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Chapter 1                                      NUON OVERVIEW 
 
Section 1.1 - What NUON Enhancement is all about! 
 

In case you haven’t heard, NUON is the latest in DVD enhancing technologies from 
VM Labs, and provides an opportunity for Movie Studios to add value to their DVD 
title releases with an expanded set of features not possible before the advent of 
NUON. 

 
NUON is, the combination of a programmable single chip media processor with 

system and application software, which enables hardware manufacturers to develop 
sophisticated and highly interactive digital video playback devices such as DVD 
Players and Set-top boxes. VM Labs has worked with our business partners to create 
a new generation of players that are more than capable of playing all the currently 
popular disc formats, such as DVD, CD Audio and Video CD. As a player, NUON 
enhances standard off-the-shelf DVDs with extremely powerful hardware based 
features. When you include the powerful software of the NUON Composition Kit on 
commercial DVD releases, the creative opportunities are virtually limitless. 

 
 

 
 

Figure 1.0.1 The Samsung Extiva N2000 NUON Enhanced DVD Player 
 
 

A NUON Enhanced DVD title, when played on a NUON-based DVD player, will 
greatly surpass the standard DVD in entertainment value. Of course, this same disc 
will play on a ‘legacy’ DVD player, but the interactive value of the title will be 
greatly enhanced when played on a NUON-based player. 

 
While we consulted with many DVD Authoring professionals to create the software 

applications that you are about to use, we’d like to hear your comments and ideas on 
how we can improve The NUON Composition Kit. This suite of applications will 
make the creation of NUON Enhanced DVDs a practical reality for your next DVD 
title release. 
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Now, if your wondering just what you’ll be adding to the DVD title, we’ll answer 
that question. ********************************************************* 

 
Section 1.2 - What is the structure of NUON Enhancement? 

 
NUON-based DVD players all have a software layer running in the background, 

much like the OS in your PC (or Macintosh if you prefer), which allows a NUON 
Enhanced disc to take control of the player in the same way that a software 
application runs on that PC. In fact NUON technology is programmable in the same 
way that a general purpose microprocessor-based computer is, and is therefore always 
going to be open to improvement and expansion of it’s capabilities. 

 
What you’ll be adding to your DVD project is essentially a software application that 

will run on a NUON based player. We’ve tried to make authoring for NUON as easy 
as possible. Often it’s as simple as typing numbers into a spreadsheet. With the 
NUON Special Feature Applications outlined in this manual, creating these NUON 
‘applications’ will be as straightforward as possible. 

 
To make the process of creating NUON Special Features easier to manage, we’ve 

made the software applications modular. That is to say, we’ve created individual 
applications that are specific to creating each of the NUON Special Features. Will 
there be more NUON features added? Will there be more Applications? Absolutely! 
And as a NUON Enhancement Author, you’ll be the first to know about them. 

 
What each of these applications does is allow you to create a NUON specific menu. 

But unlike the menus that you currently create by the standard DVD method, these 
menus are far advanced, and offer the viewer the opportunity to interact. 
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Chapter 2                              System Setup & Particulars 
 
Section 2.1 - Components of the NUON Development System 
 

The NUON Development System comprises several software and hardware 
components, which are made up of some off-the-shelf parts, as well as some that are 
proprietary to VM Labs. As well as what we provide, it will be necessary for you to 
have at your disposal, a Windows based PC to control it all.  

 
We’ll first outline these components in a general way, and then discuss each of 

them in greater detail. Here’s a list of what you should have received with your 
NUON Development System package: 
 

• The NUON DVD Reference Player 
• The NUON DVD Emulator 
• The NUON Parallel-to-Serial Converter Module 
• The NUON Hybrid Kit Software Disc 
• An Ethernet Hub 
• All necessary cabling 
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Section 2.2 - NUON Specific file formats 

 
There are a number file formats (types) that are used by NUON. In many cases 

you’ll not have to deal with these files directly, but in the rare instance when it might 
become necessary, here is a table of file formats, their extensions, and a brief 
description each. “RT” stands for Run Time, and refers to whether or not the file is 
used by NUON at the time that a disc is played on a NUON enhanced DVD player. 

 
 

 

 

Ext. Name of File Type File Type RT Comments 

. ACT Photoshop Color 
Table Files 

Photoshop 
proprietary 

 
NO 

These color table files are 
converted to NUON .NCT 
files by NUON Spectra. 

. BBO Bob Object NUON proprietary, 
Binary 

 
YES 

NUON Script Language files 
are compiled to this type for 
use by NUON at Run Time. 

.BMP Bitmap Image Standard image file, 
Binary 

 
NO 

These bitmap image files are 
converted to NUON .NPX 
files by NUON Spectra. 

.BOB NUON Script 
Language 

NUON proprietary, 
Text 

 
NO 

The Script files are converted 
to NUON .BBO binaries 
when compiled. 

.DSB Director Script 
Language 

NUON proprietary, 
Binary 

 
YES 

These files are “written” by 
NUON Composer apps for 
use by NUON at Run Time. 

.HTML Hyper Text Markup 
Language 

NUON extended, 
Text 

 
NO 

These files are converted to 
NUON .NPG files when your 
project is finally compiled. 

.NCT NUON Color Table NUON proprietary, 
Binary 

 
YES 

Photoshop Color Table files 
are converted to this type for 
use by NUON at Run Time. 

.NDC NUON Dynamic 
Chapters 

NUON proprietary 
Binary 

 
NO 

These files are for saving 
your work-in-progress, so 
that you may make tweaks. 

. NGZ NUON  
Gamma Zoom 

NUON proprietary 
Binary 

 
NO 

These files are for saving 
your work-in-progress, so 
that you may make tweaks. 

. NPG NUON Page NUON proprietary, 
Binary 

 
YES 

HTML files are compiled to 
this type for use by NUON at 
Run Time. 

.NPX NUON PiX NUON proprietary, 
Binary 

 
YES 

Bitmap files are converted to 
this type for use by NUON at 
Run Time. 

.NVD NUON Viddie NUON proprietary, 
Binary 

 
NO 

These files are for saving 
your work-in-progress, so 
that you may make tweaks. 
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Chapter 3            GUI Art, Templates & Applications 
 
Section 3.1 - Introduction to NUON GUI 

 
In this section you’ll learn just what goes into creating a NUON Enhanced GUI, 

which includes everything from creating art assets to simple coding of menu pages. 
 
You’ll want to read this section if you are a Digital Artist creating menu graphics 

for a NUON Hybrid Disc, paying special attention to the sub-sections on Art Asset 
Guidelines and the NUON Spectra color conversion application. If you’re in the DVD 
authoring field, you’ll probably want to skim these two sub-sections at the very least, 
to get a general idea as to what you can build into a NUON enhanced project. In any 
case, everybody connected with designing and creating a NUON project should be 
familiar with the concepts and terminology in this section. 

 
Section 3.2 - Art Asset Guidelines 

 
If you’ve created graphics for standard DVD menu systems in the past, you’ll find 

that everything you know about art asset creation will apply to NUON GUI art assets. 
All of your familiarity with TV color and format issues is still valid here. But since 
NUON graphic capabilities surpass those of standard DVD menu systems, you’ll 
need to know a bit more about how we create art for a NUON GUI project. As well, 
you’ll need to know about the NUON Spectra color conversion application. All of 
these issues are covered in this section. 

 
You can use just about any image creation/editing program to create the bitmap 

images used in a NUON GUI project. It is assumed that most of the Digital Artists in 
the world use Adobe Photoshop for this purpose, but it is important to note that you’ll 
absolutely have to use Photoshop for the process of indexing your images to a color 
table, as the NUON Spectra application uses Photoshop’s color table files (.ACT) for 
conversion to it’s own (.NCT) color tables. We’ll refer to that program generically 
when talking about image editing. 

 
For the most part you’ll not need to change your work habits to design and create 

NUON GUI art assets. In the following sub-sections we’ll go over the guidelines that 
you’ll need to follow in order for art assets to work correctly in a NUON GUI project. 

 
This Guidelines sub-section covers the following topics: 

 
• Assets are flattened files, saved as 8-bit .bmp 
• Images are indexed to a 230 color palette 
• Photoshop Alpha channels are not used in NUON 
• Each menu can have it’s own palette 
• NUON requires Photoshop Color Tables (.act files) 
• Indexes in the palette can be set to have translucency 
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• Image widths are multiples of 16 pixels 
• Must take safe area into account 
• Full screen images are 720 pixels wide by 480 pixels high 
• Image colors should adhere to the NTSC Gamut  
• NUON file memory is limited to approximately 2Mb ***************** 
 

Assets are flattened files, saved as 8-bit .bmp format 
 

We assume that you’ll create all of your art as multi-layered RGB images. This 
multi-layered work method is useful as it lets you create complex images that are 
built up and changed quickly when necessary. In creating art assets for a NUON GUI 
project, you’ll be able to work in this familiar method. You’ll use the .PSD format, 
which is the default for saving your work-in-progress. 

 
When you’re finished with your designs and ready to include them in a NUON 

project you’ll need to flatten the files (Via the selection of the ‘Indexed Color’ mode 
in the ‘Modes’ sub-menu of the ‘Image’ menu, which we’ll get to soon.) in order to 
save them as 8-bit Bitmap (.bmp) format files. It is important that you save these files 
as 8-bit, even if the 4-bit option is available, as NUON will not accept 4-bit files. As 
well, if you are given the option of saving only as a 24-bit file, you have probably not 
flattened and palletized the file, and should do so first. 

 
Images are indexed to a 230 color palette 

 
As just mentioned, you’ll probably be working in RGB mode throughout the 

creative part of your job, which as well as layering, means that you’ll be working in 
24-bit color mode. The NUON graphics engine currently handles only 8-bit indexed 
color images, so must convert these multi-layered, 24-bit color images to Indexed 
Color mode. And as mentioned, you must flatten the image as part of the indexing 
process. 

 
Before we go any further, a bit of info on the use of palettes by NUON. To start, the 

DVD specification allots just sixteen colors for the UI needs in all DVD players. 
NUON must conform to this spec, so we’ve set aside the last sixteen palette indexes 
(#’s 240 thru 255) for this function. These are therefore not usable for any NUON 
GUI art assets. As well, we have set aside the indexes numbered 230 thru 239 to use 
as System Colors, which are often, but not exclusively, used as font colors. So, after 
doing the math, you’ll find that there are 230 colors available for any menu in a 
NUON GUI menu. 

 
With this knowledge, we can look at indexing images to a 230-color palette. There 

are two different general cases in which you’ll be converting RGB images to the 
Indexed Color mode, so we’ll handle these individually. 

 
Case 1: A single background image. 
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In this case you’ll be converting one image to Indexed Color mode, which is the 
simplest path you can take. Follow these steps, and you’re done: 

 
1. Select “Indexed Color…” from “Modes” under the Image Menu. 
 
2. A dialog box will appear to ask if wish to “flatten” the image. Choose OK. 
 
3. A second dialog box will appear allowing you to make settings that pertain to the 

indexing process. From the “Palette” pull-down menu choose “Adaptive”. In the 
“Colors” entry field type in 230, if the number is higher than that. Don’t change the 
number if it’s less than 230. Choose “None” for the Dithering option. And finally, 
select the “Best” radio button for the Color Matching option. Click Ok, and your 
done. 

 
4. Carefully inspect the image for signs of banding and other color reduction 

weirdness. 
 
5. If you’re happy with the image conversion, save the Photoshop Color Table for 

this image, as you’ll need it later. To do this select “Color Table” from the “Modes” 
sub-menu under the Image Menu. The Color Table will appear, where you’ll choose 
to save it. Keep this Color Table file near the image file, and type in the file 
extension “.act” if you’re working on a Mac. The Color Table file will be used by 
the NUON Spectra Color Conversion Application, which runs only under 
Windows. 

 
Case 2: Multiple images with bullets and/or bitmap text. 
 

In this case you’ll be converting several images to use a single palette *********** 
******************************************************************* 

 
Photoshop Alpha channels are not used in NUON 
 

While you can use Alpha Channels and Transparency masks in your NUON GUI 
art assets, these will not control transparency in the final NUON menu that you’re 
creating art for. Remember, you’ll be flattening the image and converting it to 
Indexed Color mode. 

 
You can have transparency in your NUON menus, but it is handled in a different 

manner for NUON GUI graphics. We’ll get into this in depth in the sub-section on the 
NUON Spectra Color Application.  

 
NUON requires Photoshop Color Tables (.act files) 
 

In order to conserve space in memory, as well as to display images more rapidly, 
color tables are stored separately from NUON image files. This allows several NUON 
images files to share a single color table file, and avoid reloading the color table if it 
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was not changed, though it is not absolutely necessary that you do this. In order to 
display images NUON will need a palette to work from. This palette will eventually 
end up being in a proprietary format, as will be discussed in the sub-section on 
NUON Spectra, but for now suffice it to say that you’ll need to save the Photoshop 
Color Table that your images are indexed to.  

 
Each menu can have it’s own palette  
 

Though you can have only 230 colors per menu, you are allowed to have a 
completely different palette for each menu displayed by NUON. So, if for instance, 
you have four menus to be displayed, you can have a separate 230-color palette for 
each of them. This should better allow you to cover the range of colors presented in 
each menu that you create for a NUON GUI project. 

 
Please note that you can have only one color table per menu being displayed at any 

one time. This would include menus with only a single image used as a background, 
as well as menus using foreground images such as bullets or bitmaps as text. In the 
latter case all of the additional bullets; text and art assets are indexed to the same 
Photoshop Color Table as the background image.  

 
Art & Code Templates 

 
Text 
 

NUON Flavored HTML 
 
Text 
 

NUON Scripting Language (.bob) 
 
Text 
 

The NUON Build Environment 
 
Text 
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Chapter 4                                         NUON Spectra Reference    
 

Section 4.1 - An Introduction To NUON Spectra 
 

The NUON Spectra color conversion application is a powerful image and color 
table conversion tool, which also allows digital artists creating NUON art assets to 
accurately set transparency levels within artwork where necessary. As well, art assets 
can be exported from NUON Spectra and viewed on the NUON Reference Player to 
test for appropriate appearance on TV monitors. 

 
When using NUON Spectra, you’ll load bitmap images (.bmp format) and 

Photoshop color tables (.act format) and see combination of the two files in NUON 
Spectra’s view window. As well, you can load a bitmap image that will serve as a 
placeholder for the video images that will eventually be shown through your menu 
art. Once you have set the transparency levels of the area that the video image will 
show through, you’ll export NUON Color Table (.nct format) and NUON Picture 
eXport (.npx format) files for use in NUON Menus. 

 
Section 4.2 - Working with the NUON Spectra Main Window 

 
Let’s get started with NUON Spectra right away. First, you’ll need to locate the 

Spectra.exe in the following path, NUONComposerKit\bin. Double-click the 
application icon and you’ll see a window that looks like Figure 3.1.1. 

 

 
Figure 3.1.1 The NUON Spectra Main Window 
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This is the NUON Spectra Main Window, which is where you’ll load and view files. 
The most notable feature of the Main Window is the Image View Window, which is the 
large black area in Figure 3.1.1. Above the Image View Window you’ll find a standard 
menu bar with File and Help pull-down menus. To the right are the Color Table Scroll 
Window, RGB & A value fields, a swatch of the currently selected color. Below the 
Image View Window are the image and color table load buttons. The Main Window 
shown in Figure 3.1.1 is of course empty, and therefore has no color table or image 
loaded, so we’ll start off by loading up all of the necessary files. 
 
Section 4.3 - Loading Files Into NUON Spectra 
 

There are three types of files that you’ll be loading into NUON Spectra. These are; 
bitmap image files (.bmp files in 8 & 24 bit formats) and Photoshop Color Table files 
(.act format). Each of these files plays a part in viewing images in NUON Spectra. 
Please note that none of the file types that are to be loaded in to NUON Spectra is 
ever saved or opened via the File Menu’s Save command, which saves only NUON 
specific color table files. This will be discussed in greater detail later.  

 
We’ll now look at the rolls that each of these files plays and delve into the 

functionality of NUON Spectra all at the same time. 
 

Section 4.3.1 - Load Background Image 
[24-bit Bitmap Images (.bmp)] 

 
To load a background image to help verify 

transparency layers, click on the “Load 
Background Image” button below the Image 
View Window as shown in Figure 3.1.2. You’ll 
then be presented with a standard Open Dialog 
Box, where you can select an image for loading. 
Once loaded, the name of the image will be displayed in the text field to the right of 
the Load button. 

 
 
Figure 3.1.3 shows a bitmap loaded as a 

Background Image. You’ll note that the 
image appears to be of only that of a “Jet 
Pilot” floating around in the upper right-
hand corner of the Image View Window. 
In this case, the “Jet Pilot” image has been 
layered on a 720 X 480 pixel black 
background (in Adobe Photoshop) then 
flattened to save as a 24-bit bitmap image, 
so the image is filling the entire 720 X 480 
pixel space. Its’ just mostly black! This 
has been done for a reason, which we’ll 
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get to soon when we look at loading and working with color tables. 
 
Note that you do not have to use a background image to work with this application. 

This function is included for your benefit as an artist, and will allow you to see your 
menu art designs with a still image showing through any translucent areas in the 
image. Without a background image loaded the default background is solid black, 
which may work just fine for your needs. Background images are required to be 720 
pixels wide X 480 pixels high, as they are used as a placeholder for full screen video 
assets that will be shown through the artwork when it is presented as a NUON menu. 
These images must have a bit depth of 24 bits. Background images are not 
incorporated into the final art asset when exported from NUON Spectra; so don’t 
worry too much about their quality. 

 
You would probably want to use frame grabs or scans of promotional stills from the 

title that you’re designing for in order to check transparency settings that you’ll make 
in the in the Overlay art. 

 
Section 4.3.2 - Load Overlay Image 
[8-bit Bitmap Image (.bmp)] 
 
To load an Image to be used in a NUON 

menu, and therefore to be converted to the 
NUON .npx format, click on the “Load Overlay 
Image” button, below the Image View Window 
as shown in Figure 3.1.4. You’ll then be 
presented with a standard Open Dialog Box, 
where you can select an image for loading. Once loaded, the name of the image will 
be displayed in the text field to the right of the Load button. Please note that you must 
have a Photoshop Color Table loaded in order to see the Overlay Image that you 
have loaded. See the next section for more info. 

 
Figure 3.1.5 shows a bitmap loaded as 

an Overlay Image. This type of image is 
used by NUON Spectra as the source for 
conversion to the NUON image file format 
(.npx). These 8-bit image files will have, 
of course, been indexed to an 8-bit color 
table, which you’ll create and then save 
from Adobe Photoshop. Please note that 
you’ll also need to load a color table to see 
this image. The method for doing this is 
described below, and the Load Photoshop 
Color Table button and window are shown 
in Figure 3.1.6. 
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One of the first things that you’ll notice in this image (other than the cool retro 
space guys) is the 100% magenta shape in the upper right-hand corner. Referring 
back to Figure 3.1.3, you’ll note that this magenta shape just happens to be right 
where our “Jet Pilot” is, and we did say that there was a reason for that guy being 
where he was. Also, take note that the Color Table area to the right of the Image 
View Window has been filled in. It wasn’t used in Figure 3.1.3, because the 24-bit 
image didn’t need the color table, but this 8-bit image does. 

 
You’ve probably already figured out that the magenta shape is eventually going to 

be a Transparency area, where the “Jet Pilot” is going to show through. This 
assumption would be correct. For this example, we’ve chosen to use magenta for this 
purpose because it isn’t used anywhere else in the image, and we want this area to be 
a unique color for setting the Alpha Value to be transparent. This will be discussed in 
the next sub-section on the color table. 

 
Section 4.3.3 - Load Photoshop Color Table 
[Adobe Color Tables (.act)] 

 
To load an Adobe Photoshop Color Table 

used for ‘coloring’ the Overlay Image that 
you’ve loaded, click on the “Load Photo-shop 
Color Table” button, below the Image View 
Window, as shown in Figure 3.1.6. You’ll then 
be presented with a standard Open Dialog Box, 
where you can select a color table for loading.  

 
After you’ve selected a color table and clicked OK, you’ll be presented with a 

dialog box as shown in Figure 3.1.7. This is the Alpha Setting dialog, where you can 
set all of the color table’s Alpha Values to a specific setting. You’ll note that there are 
two illustrations of the Alpha Value box in the figure. The one on the left has it’s 
“Keep Current Alpha Values” radio button selected, which means that all of the 
Alpha Values will be set to a default value of 0, and therefore be opaque. In the right-
hand illustration, the “Reset Alpha Values To:” radio button has been selected and the 
number field value has been set to 128, which sets all of the Alpha Values to 50% 
opacity. This will cause the image to become translucent. If a value of 255 were used, 
the image would become totally transparent.  

 
Which one of these options you chose depends upon what type of an effect you’re 

trying to accomplish. If for instance you have an image like the ones shown in our 
examples (“Space Guys”), and there is going to be a simple ‘video viewing area’ (the 
magenta shape), you’ll choose to Keep Current Alpha Values, which will set all 
Alpha Values to 0, or fully opaque. It’s then a very simple matter to locate the 
translucency color indexes (we’ll get to this in short order) and set their Alpha Values 
to something other than 0. We’ll choose to set them to 128 for our example. If on the 
other hand, you wanted to have the whole menu image appear translucent you would 
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choose to Reset Alpha Values, and set an appropriate Alpha Value, remembering that 
0 is opaque and 255 is completely transparent. 

 

  
 

Figure 3.1.7 The Alpha Value dialog box. 
 
Once loaded, the name of the color table will be displayed in the text field to the 

right of the Load button. As well, the Color Table area of the window as shown in 
Figure 3.1.8 will be filled in. 

 
Section 4.4 - NUON Spectra Color Table Basics 

 
So far, we’ve loaded two bitmaps into NUON Spectra, one of them 

a 24-bit Background Image, and the other an 8-bit Overlay Image. It 
was stated earlier that you’d need to load a color table to see the 
Overlay Image that you’ve loaded. Because a standard bitmap’s 
internal color table cannot have alpha values set, we’ve separated it 
from the image. This is done to allow you to set the specific colors in 
the table to be translucent.  

 
Figure 3.1.8 shows the Color Table as a scrolling list type window, 

where you’ll use the scroll bar to locate the color(s) that you’d like to 
set the Alpha Value(s) for. Below the scrolling list are the Red, 
Green and Blue level windows, which since they’re grayed out you 
can’t change, and the Alpha Value number window. You can use the 
RGB values shown to help identify the specific color that you’re 
looking for. And finally, there is a swatch of the currently selected 
color index shown below the Alpha Value window. 

 
In the case of our “Space Guys” example, we’ve set aside three 

shades of magenta as translucency colors for the view window in the 
menu. We’ve used three index colors because this magenta shape has 
rounded edges, and when using such a shape, it’s usually a good idea 
to have some anti-aliasing to smooth the edges out a little. If this 
were a rectangle with straight edges and squared off corners we’d 
use only one index color for translucency. In Figure 3.1.8 we can see 
the three index colors, which are numbered 3, 4 and 6. In this case, 
index 6 is the main translucency color, and 3 & 4 are the anti-
aliasing colors. 
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When one of these color indexes is 
selected by clicking on the colored 
swatch next to the index number, 
something quite useful will happen. As 
shown in Figure 3.1.9 any pixels in an 
image that are colored with the selected 
color index will alternately flash their 
color and white. (Which of course we 
really can’t show in a screen shot, but 
you get the idea.) In this example, the 
index for the main part of the view 
window has been selected, which is 
index 6. If there were any other pixels in 
the image that used this color index, they would be flashing too. If that were to 
happen, you would want to eliminate these by ‘spotting’ them out in Adobe 
Photoshop. You’ll do this by selecting another color close in hue, that isn’t going to 
be used as a translucent color (Don’t for example, use one of the anti-aliasing colors, 
or you’ll have the same problem with another set of pixels.), and penciling the errant 
pixels in with the newly selected color. 

 
If, as in Figure 3.1.9, there are no 

errant pixels flashing, you can proceed 
to set the Alpha Value for the color 
index. To do this click in the number 
field next to the letter ‘A’ below the 
RGB values, and type or select a value 
with the up/down spinners. You won’t 
see an immediate effect, but selecting 
another color index in the Color Table 
will cause the Alpha Value that you  
have set to take effect, and show the 
translucency values effect on the 
Overlay Image.  

 
Figure 3.1.10 shows the outcome of setting color indexes 3, 4 & 6’s Alpha Values 

to 128, which will give those indexes a 50% translucency. And finally, we see the 
“Jet Pilot” Background Image once more, showing through the 50% translucent 
magenta view window. We could have set the Alpha Values for the magenta indexes 
to 255, which would have rendered them completely transparent. This is what you 
would most likely do in a real menu art design, but it better illustrates the trans-
lucency effect to set it to a median value, where the index’s color is still apparent. 

 
With the last step, we showed the greatest value of NUON Spectra, where 

individual color indexes of the Color Table can be set to specific Alpha Values. Now 
we’ll look into what is done with this work and how it is exported and converted. 
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Section 4.5 - Outputting NUON Specific Files 
 
There are three file types output by NUON Spectra. Two of these are used 

by NUON to display menus, and the third is used only to save any work that you have 
done on the Color Table. We’ll discuss the NUON specific files first. These include 
the NUON Color Table (.nct) format, which is exported via the File Menu, and the 
NUON Picture eXport (.npx) format, which is converted via the File Menu. The other 
file type is the Color Table (.ctb) format, which again is only for saving your Alpha 
Value settings for further adjustment, if necessary. 

 
Section 4.6 - NUON Color Table Files 

 
Since NUON is capable of using alpha values to set the translucency of color 

indexes in a color table, and bitmap images aren’t capable of containing alpha values, 
it is necessary to split the color table data from the bitmap image, and then output that 
color table as a separate file. This is another part of what NUON Spectra allows you 
to do. This is a multi-stepped process, which we’ll delve into now. 

 
Section 4.7 - Loading and Exporting The System Clut 

 
Before you output the NUON Color Table (.nct) files that will be used by NUON to 

display your menu art assets, you’ll first need to export a NUON System Clut (Color 
Look Up Table), which will be used when you are ready to export your .nct files. This 
is something that you’ll want to do before you are ready to Export your final Color 
Table, as it is required that you have this file available during the final Export 
process. Before we go through the steps to export the System Clut, we’ll briefly 
discuss what a System Clut is and what it is used for. 

 
The System Clut consists of a group of 

ten color indexes numbered 230 thru 
239. These colors are used by NUON to 
do a number of things including; serving 
as text colors and colors for on-screen 
graphics such as the Zoom Indicator 
Box. Since this Clut gets used for 
displaying objects that you are not 
creating, and therefore have no control 
over, you should only make use of the 
first four indexes in the color table, 
which NUON does not rely upon.  

 
You can edit the System Clut colors 

only in the Adobe Photoshop Color 
Table dialog box. Figure 3.1.11 shows 
that dialog box with the first ten indexes set to the NUON System Clut colors. We’ve 
included a copy of this Color Table in the Tutorial Files directory of the Composer 
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Kit for your use. Again, do not change any but the first four colors of this Color Table 
as you can adversely affect system graphics that you may not be aware of.  

 

 
Section 4.8 - The following are outline descriptions of all 
remaining NUON Spectra functions: 
 
To start a New Spectra Project: 
 

1. From the File Menu select New Project. If there is a 
currently opened and un-saved project you’ll be 
prompted to save that projects color table file.  

 
To “Open” a previously saved .ctb file: 

 
1. From the File Menu select “Open Color Table” 
 
2. When the standard open file dialog box appears double-

click the .ctb that you wish to open or click the Open 
button. 

 
To “Save As” a color table for later editing: 
 

1. With a color table loaded into Spectra select “Save 
Color Table As” from the File Menu. 

 
2. In the standard File Save dialog box that appears name 

and save the file. The file will be saved in the .ctb 
format. 

 
To “Save” a previously saved color table file. 
 

1. With a color table loaded into Spectra select Save from the File Menu. 
 
To load and “Export” a NUON System Clut: 
 

1. Click Load Photoshop Color Table button below Image 
View Window. 

 
2. Select the System.ACT color table from the standard 

Open dialog that is presented. 
 

3. Set the Alpha Value of color #7 (Red) to 255. 
 

4. From the File Menu select Save Color Table, then name 
it and save it in the standard Save dialog that 
appears. 

 
5. From the File Menu select Export NUON System Clut, 

then name and save it in the standard Save dialog that 
appears. 
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To ”Export” a NUON Clut: 

 
1. Load a Photoshop color table and adjust alpha values as 

described in the above section titled “Load Photoshop 
Color Table”. 

 
2. From the File Menu select Export NUON Clut, then name 

and save it in the standard Save dialog that appears.  
 

3. Select a system clut when the “Select System Clut File” 
dialog appears. Hit Select and the file will be 
exported. 

 
 
To “Convert” a bitmap image to NUON format: 
 

1. Load an 8-bit .bmp image as described in the above 
section titled “Load Overlay Image”. 

 
2. From the File Menu select Convert Overlay, then name 

and save it in the standard Save dialog box that 
appears. 

 
3. When the “Select NUON Clut” dialog appears select the 

Clut that you saved as in the “Export NUON Clut” step 
above. 

 
To “Batch Convert” several bitmap images to NUON format: 
 

1. From the File Menu select Batch Convert Overlay, then a 
Batch Convert dialog will appear. 

 
2. Under the “Selected Image Files” list click on the 

Select button, then a standard Open File dialog will 
appear. 

 
3. Select the files that you wish to convert, and click 

Select. The files will be added to the Selected Image 
Files list. 

 
4. Under the “NUON Clut File” box click on the Select 

button, then a standard Open File dialog will appear. 
 

5. Select a Clut file to be used for the batch conversion 
and click on select. The clut file will show up in the 
box. 

 
6. Click the Convert button in the bottom right hand 

corner of the dialog box. The files will be converted 
to .npx format files and saved in the same directory 
that the .bmp files came from. 
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To do a preview an image with “Export Preview” 
 
1. YOU MUST HAVE A NUON REFERENCE PLAYER CONNECTED AND 

RUNNING TO DO THIS PREVIEW FUNCTION. 
 
2. With an image loaded into Spectra select Export 

Preview from the File Menu. 
 
3. In the select NUON clut dialog box that appears select 

the NUON color table (.nct) file that you wish to test 
the image with and click Open. 

 
4. The file will be exported to the appropriate 

directory. 
 

5. Open a DOS Box and navigate to the Composer Kit\test 
directory and type in composerun at the prompt (>).  

 
6. When all of the DOS stuff is completed and the player 

begins running again, press “MEMU” on the NUON 
Reference Player remote control, and navigate to 
“Preview Image” then press the “ENTER” key on the 
remote. Your image should now be displayed. 

 
To Exit the program: 
 

1. From the File Menu select Exit or Click on the Close 
Box in the upper right-hand corner of the Main Window. 
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Chapter 5                  NUON Special Feature Composers 
 
Section 5.1 - What are NUON Special Feature Composers? 
 

We’ve talked about NUON Special Features and alluded to the software 
applications that you would use to create them, but what are these applications? The 
Composers as we’ll call them, are a suite of software programs that allow you to 
create specific NUON Special Features. The Composers at the time of this release of 
NUON Composition Kit are: 

 
• Viddie Composer   Creates Viddies Montages 
• Gamma Zoom Composer  Creates Gamma Zoom with Vista Points 
• Dynamic Chapter Composer Creates Dynamic Chapter Selections 

 
These NUON Special Features are open to change as well as the addition of new 

features in the future. As a NUON Features Author you’ll be kept up to date as to any 
improvements or additions to the Apps. 

 
When you use a NUON App, you’ll simply enter information about the NUON 

Special Feature that it will generate, which will most likely be specified by the 
Creative Producer of the project, then press Export and be done. What you’ll have 
created are the files necessary to run the NUON Special Feature, but not the code for 
the Special Features Menu itself. That is discussed in depth in Chapter 3 of this 
manual, GUI Art, Templates & Applications. 

  
Section 5.2 - NUON Composers are standard Windows Applications 

 
The NUON Composer Kit applications are standard Windows applications, and as 
such use the same interface that you’re already familiar with from working with other 
Windows applications. 
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Chapter 6                                    The Viddie Composer    
  

Section 6.1 - An Introduction to NUON Viddies 
 
Viddies are a way for creative types at the movie studio to add value to a title by 

creating thematic montages of Viddie Clips. These could, for example, be a montage 
of explosions in an action film, or kisses in a romantic drama, or explosive-corrosive-
acid-soaked-kisses in a sci-fi thriller! The options are endless and totally in the 
control of the Creative Producer. 

 
The real power of Viddies, like other NUON Enhancements, is that they are built 

upon an already completed film. No additional editing or replication of the film asset 
is necessary. In addition, Viddies can span all of the titles on a DVD being NUON 
Enhanced, so the main feature, as well as theatrical trailers, deleted scenes and 
director’s cuts can be used in a Viddie Montage. 

 
Section 6.2 - What is a Viddie Montage? 

 
Similar to the way a film editor cuts together all the parts of a film, Viddie 

Composer allows a Creative Producer to edit together new thematic segments from a 
master program. Say a studio is putting out the aforementioned sci-fi thriller and want 
to do the kissing Viddie Montage. First, the Creative Producer would start by locating 
all of those ‘kissing’ parts of the film and note their DVD Run-times (They’ll need to 
list both in and out times, of course). What will have been generated is a run list for a 
single Viddie Montage with each of the ‘kissing’ scenes, which we refer to as Viddie 
Clips, and their individual in and out time codes. As well, each Viddie Clip can have 
descriptive text to relate its importance in the Viddie Montage, which will be shown 
in the Viddies Menu. Figure 4.1.1 shows the relationship between a Viddie Montage 
and it’s associated Viddie Clips. 

 

 
 

Figure 4.1.1 The relationship between a Viddie Montage and Viddie Clips. 
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Please note in the previous illustration, that the selected Viddie Clips do appear in a 
scrambled order. This is intentional, to illustrate how Viddie Clips can be pulled from 
any part of a title, and arranged in any order. In fact, Viddie Clips can be pulled from 
any Title that appears on the DVD, including Director’s cuts, deleted scenes, and 
theatrical trailers. 

 
 The Creative Producer doesn’t have to stop at one Viddie Montage. In fact, we’ve 

set up templates, which will allow you to build menus with several (up to 16) Viddie 
Montages on them. So, for instance, a Viddie Montage for each of the lead actor’s 
one-liners, kisses and karate chops could be included. Once the run lists for all of the 
desired Viddie Montages have been compiled, they’ll be sent to you, the NUON 
Enhancement Author by the Creative Producer. You’ll then go on to add these run 
lists to menu art and code templates with the Viddie Composer, which we’ll get to 
after just one more explanation of what this is all about. 

 
Section 6.3 - How NUON Viddies are presented to the viewer 

 
Sitting in their favorite easy chair, the viewer will be entertained by all of this 

creative work by simply selecting the Viddies Menu, navigating to the desired Viddie 
Montage and pressing enter. Figure 4.1.2 shows an example of one of the menu 
templates that we’ve included in this NUON Composer Kit.  

 

 
 

Figure 4.1.2 A NUON Menu Template, what the viewer sees. 
 
In the figure above, you’ll note first that this is a full screen bitmap image (720 × 

480 pixels) much like any other piece of DVD menu artwork. One big difference 
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between this piece of art and the usual is that NUON allows for “picture-in-graphic” 
display. So, though not apparent here, the pair of swimming whales actually appear in 
a scaled down video window, in real time, and moving! Another notable thing about 
NUON Features Menus is that text can be displayed dynamically, which is to say that 
menu items or other text, such as the “Scene Description” text (the white text), isn’t 
included in the bitmap image. This text is displayed by NUON, and is based on the 
text that you’ll be entering to the Viddie Composer. Other graphic items, such as 
logos and heading text, will still be part of the background bitmap.  

 
Section 6.4 - Working With The Viddie Composer 

 
So far, we’ve only given an introduction as to what Viddies are. So let’s open the 

application and get to work! First, you’ll need to locate the viddieComposer.exe in 
the following path, \NUON Composer Kit\bin. Double-click the application icon and 
you’ll see a window that looks like Figure 4.1.3. 

 

 
 

Figure 4.1.3 The Viddie Composer Main Window. 
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This is The Viddie Composer Main Window. It’s extremely simple to use. You’ll 
enter pertinent Viddie Montage information, and also test your Viddie Montages for 
timing accuracy and thematic flow. The Viddie Composer is a standard window with 
a menu bar at the top, text entry fields, and buttons to make selections.  

 
One of the most notable features of this window is the Viddie Clip Chart, which 

takes up most of the window real estate. This is where all of the Viddie Clip info for 
the particular Viddie Montage that you’re working on will be displayed. You won’t 
be making any changes here, but this chart is no less important, as it displays all of 
the info about the Viddie Montage that you’re creating. Just above the chart is the 
Viddie Montage Name text field, to the right are the Viddie Action Buttons, and 
below the chart are the Viddie Clip Setting fields, which is where all of the important 
Viddie Clip info is entered. 

 
In our example above, the Viddie Montage is named “Stuff Blows Up” (the Viddie 

Montage Name), and includes three Viddie Clips named; “Car Blows Up”, “House 
Blows Up”, and “Guy Blows Up”. Each of these has a Title number, In/Out Times, 
and some descriptive text. When exported, all of this information will produce a 
single Viddie Montage named “Stuff Blows Up”. 

 
Section 6.5 - Instant Gratification (A tutorial) 
 

We’ve told you enough about what Viddies are, and a bit about the Viddie 
Composer, so finally, let’s look at how you’ll create Viddies. We’ll do this in a step-
by-step fashion, so you’ll see just how simple it all is. You can make up text and 
times for this tutorial as you go along. This is just for fun, right! 
 
1. If you have not done so already, you’ll need to start the Viddie Composer 

application, which you’ll find in the following path, \NUON Composer Kit\bin. 
Double-click the viddieComposer.exe icon to start the application. 

 
2. If your development system includes a DVD Emulator, make sure the DVD 

Drive/Emulator data switch is set to DVD Drive position. You’ll find information 
on the DVD Emulator in a separate document included with that module. 

 
3. Make sure that your NUON Development System is powered on. 

 
4. Load a DVD disc into the Reference Player disc drive. 

 
5. Select New from the File Menu if you’ve entered any info while playing around, 

and choose No in response to the “save changes” dialog. 
 

6. Enter a Viddie Montage Name in the appropriate text field. 
 

7. Click the “Add Clip” Action Button at which time an “Untitled Clip” will appear 
at the top of the Viddie Clip Chart. 
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8. Enter a Clip Name in the appropriate text field. 

 
9. Enter a DVD Title number into the appropriate text field. Alternately you can use 

the up/down arrows. 
 

10. Enter a Time In and Out. Note that you can tab from field to field and enter two 
digit time values. You can also use the up/down arrows to set values if you like. 

 
11. Enter some descriptive text in the appropriate field. 

 
12. Now, repeat steps 6 through 10 to add more Viddie Clips to this Viddie Montage.  

 
Pretty simple! You’ll note that if you continue to Add Clips that they are appended 

to the end of the chart. The Viddie Clips will appear in the Viddie Montage in the 
same order as they appear in the chart.  

 
You can play Viddie Clips from any part of the movie in any order. (As shown in 

Figure 4.1.1) The Viddie Montage can go from end to beginning, or skip around, and 
can even jump from title to title! Before we go on to test and export Viddies, let’s 
have a look at the other Viddie Clip Action Buttons. They are as follows: 
 

• Insert Clip, which will insert a new Viddie Clip into the Viddie Clip Chart 
above the currently selected Viddie Clip. 

 
• Delete Clip, which will delete the currently selected Viddie Clip from the 

Viddie Clip Chart. There is NO undo function for this, so be careful. 
 

• Move Up, which will move the currently selected Viddie Clip up the Viddie 
Clip Chart, and therefore to an earlier position in the Viddie Montage. 

 
• Move Down, which will move the currently selected Viddie Clip down the 

Viddie Clip Chart, and therefore to a later position in the Viddie Montage. 
 

And if you wanted to save this work, you would select “Save As” from the File 
Menu, and enter a name for the project in the standard Save Dialog Box that appears. 
This is not the same as doing an export, which we’ll learn about below. 

 
Once you’ve added all of the Viddie Clips and input their settings, you’ll want to do 

something with all of this valuable data. This is going to be easy, assuming that you 
already have your NUON Development System running. All you have to do is simply 
click on the Test Viddie action button, and watch the Viddie Montage roll before your 
eyes. Again, it’s just that simple! Of course you may want to tweak some of the 
In/Out Times to avoid cutting on scene changes, but then you just click that Test 
Viddies button again to see your changes. 
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Now that you’ve tested your Viddie Montage, as in the last step, you’ll want to put 
it to use. All you have to do is click on the Export Viddie action button. A dialog box 
will appear and prompt you to select a Viddie number. For now, leave it set to 1, and 
click OK. This will automatically Export your work to a NUON file format, title it 
“viddie1”, and put it into the appropriate directory. This is the final step in the 
creation of a Viddie Montage.  

 
In a real project there will no doubt be several Viddie Montages that will appear on 

the Viddies Menu, so the previous set of steps will be repeated for each Viddie 
Montage. The only difference when creating a real project would be the selection of 
the Viddie number in the Viddie Export step, where you’ll select the number based on 
what the Creative Producer has specified. 

 
For a detailed description of the functioning of all text fields, buttons, and menus of 

the Viddie Composer see the Viddie Composer Reference section of this manual. 
 

Section 6.6 - Putting It All Together 
 
Once, you’ve entered the data and exported each of the Viddie Montage files, you’ll 

want to see them in the context of a menu. Though this is discussed in greater detail 
in Section 3 NUON UI Templates & Tools, we’ll briefly discuss the process here. 

 
We’ve included templates for building NUON Menus in the Composer Kit. These 

templates include both the menu code and bitmaps. These are to allow you to quickly 
see how a NUON project is built, and to give an idea of how it will look when done. 
Please note that the included bitmaps have generic headings, titles, and menu item 
text. They have been included as a starting point for Graphic Artists developing for a 
NUON Features project, as well as system test for the Development System. 

 
To build and load a NUON project to your development system you’ll need to 

follow these steps: 
 
1. If your development system includes a DVD Emulator, make sure the DVD 

Drive/Emulator data switch is set to the DVD Drive position. You’ll find 
information on the DVD Emulator in a separate document included with that 
module. 

 
2. Make sure that your NUON Development System is powered on. 

 
3. Load a DVD disc into the Reference Player disc drive. 
 
4. Locate and open the MS-DOS Prompt (also referred to as the “DOS BOX”), 

which you’ll find under Programs in the Start Menu. 
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5. You’ll need to navigate to the “test” directory within the NUON Composer Kit 
directory. If you’re not familiar with DOS-Prompt, command-line use or the ‘cd’ 
command see Appendix A on the DOS-Prompt. 

 
6. After the prompt, (“>”) type “makedat” to start the makedat batch file. This will 

automatically build your NUON project. If this seems to go by rather quickly, 
that’s normal, as NUON Menu files are compact and are compiled very quickly. 

 
7. After the prompt, type “load” to start the load batch file. This will take between 

12 and 15 seconds, and will display the percentage completed of each of the files 
loaded to the Development System. When complete, the currently loaded disc 
should begin to play. 

 
8. Press the Menu button on the remote to bring up the NUON Features Menu. This 

won’t say NUON Features on it, as it’s a generic template graphic. 
 

9. Navigate to “Viddies” with the up/down arrow keys, and press enter to open the 
Viddies Menu. It won’t say Viddies Menu. 

 
10. The menu should open with “Viddie 1” already selected. Press enter to start your 

Viddie Montage running. When it does, it should look exactly as it did when you 
ran Test Viddie in the step-by-step in the Instant Gratification section. 

 
That’s it! You’ve just built and loaded a NUON project into the Development 

System. With that said, this was just a trial run, and in order to build a real project 
you’ll want to go over Section 3 . The rest of this Section is comprised of a reference 
document, which describes in great detail all of the functions of the Viddie 
Composer. 
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 Section 6.7                        Viddie Composer Reference 
 
 
Standard Pull-Down Menus 
 
File Menu 
 
Figure 4.1.4 shows the File Pull-Down Menu. This 
menu can either be pulled down with your pointing 
device, or invoked by the key combination Alt + F. 
Once pulled down, functions can either be selected 
with the pointing device, or invoked by hitting the 
key that corresponds to the underlined letter in the 
function name. 

 
New (Ctrl+N) 
 
Creates a New Viddie Montage window by clearing 
the existing window of its contents. If there is an 
already opened Montage window, you’ll be prompted 
to save your current work through a standard warning dialog box.  
 
Open (Ctrl+O) 
 
Opens a Viddie Montage file that you have saved. The “Open” dialog box will be 
displayed where you’ll select a file to be Opened. If there is an already Open file at 
the time that you choose to Open another, you’ll be prompted to save your current 
work through a standard warning dialog box. 
 
Viddie Composer files have the file extension .NVD and are only read by The Viddie 
Composer. This is the format in which you’ll save your work-in-progress, as well as 
finished projects, which you may wish to keep for future reference. These are not the 
files that you’ll include in your final NUON menu project. Those files are discussed 
below under the Export Viddies button heading. 
 
Save (Ctrl+S) 
 
Saves the currently opened project if it has been previously “Saved As”, otherwise 
you’ll prompted to name the project in the standard Save As dialog box. 
 
Save As (Ctrl+A) 
 
Saves the currently open in the Viddie Composer (.NVD) format. The “Save As” 
dialog box will be displayed, and you’ll be prompted to enter a file name. 
 

VM Labs, Inc.




 30 

Print (Ctrl +P) 
 
Prints the contents of the current Viddie Montage to a connected printer. You’ll be 
presented with a standard Windows print dialog box, where print options may be 
selected. 
 
Print Setup 
 
Presents a standard Windows Print Setup dialog box, allowing you to set print 
parameters for your documents. 
 
Recent Files 
 
The Recent Files area between the Print function and the Exit function is a standard 
Windows feature showing exactly that. Up to four of the last files worked with will be 
displayed here. 
 
Exit 
 
Exits the Viddie Composer application. You will be prompted to save any un-saved 
work through a standard warning dialog box. 

 
Edit Menu 

 
Figure 4.1.5 shows the Edit Pull-Down Menu. We’ll 
only give a brief description of these menu functions 
as all of them duplicate buttons in the Viddie 
Composer Main Window, and will be discussed in 
detail later. This menu can either be pulled down with 
your pointing device, or invoked by the key 
combination Alt + E. Once pulled down, functions 
can either be selected with the pointing device, or 
invoked by hitting the key that corresponds to the 
underlined letter in the function name. 
 
Add Clip (Ctrl +A) 
 
Adds a New Viddie Clip to the end of the current Viddie Montage.  
 
Insert Clip (Ctrl +I) 
 
Inserts a New Viddie Clip above the currently selected Viddie Clip. 
 
Delete Clip (Ctrl +D) 
 
Deletes the currently selected Viddie Clip from the Viddie Montage.  
Beware: there is NO undo function for this! 
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Move Up (Ctrl +Up) 
 
Moves the currently highlighted Viddie Clip up the Clip Chart, to an earlier position 
in the Viddie Montage.  
 
Move Down (Ctrl +Down) 
 
Moves the currently highlighted Viddie Clip down the Clip Chart, to a later position 
in the Viddie Montage. 
 
Test Montage (Ctrl +T) 
 
Directly loads your Viddie Montage file to the NUON Reference Player, and plays it. 
 
Export Montage (Ctrl +E) 
 
Is the final step in creating your Viddie Montage, which exports the current Viddie 
Montage in the Director Script (.DSB) format. 

 
Help Menu 

 
Figure 4.1.6 shows the Help Pull-Down Menu. This 
menu can either be pulled down with your pointing 
device, or invoked by the key combination Alt + H.  

 
About NUON Viddie Composer 
 
You can find the software revision number here.  
 
Viddie Montage Name 
 

Figure 4.1.7 shows the Viddie 
Montage Name window, which is 
where you’ll enter the text that will be 
displayed as an individual menu item 
in the Viddies Menu. This is an important text field as it directly effects what is 
displayed on the finished menu. So beware, speling an d capitolizashun Coun 
hear! 

 
Montage TRT (Total Run Time) 
 
Figure 4.1.8 shows the Montage Total Run Time 
Display, which totals the run time for all clips in the 
current Viddie Montage. Time is shown in 
HH:MM:SS:FF format. 
 

VM Labs, Inc.




 32 

 
Viddie Clip Chart 
 

Figure 4.1.9 shows the Viddie Clip Chart, which is where you’ll add, insert, 
delete and otherwise arrange Viddie Clips into Viddie Montages. This is the main 
display area of the Viddie Composer, and most of the other controls in the main 
window have a direct effect on the chart. 

 
The only direct effect that you can have on the chart is to select individual 

Viddie Clips for editing (with the aforementioned controls), as well as resizing the 
chart columns to accommodate showing text of differing lengths, though this 
shouldn’t be necessary most of the time.  

 

 
 

Figure 4.1.9 The Clip Chart 
 

Viddie Clip Settings 
 
Figure 4.1.10 shows the Viddie Clip Settings area. This is where you’ll make all of 
the settings for each of the Viddie Clips in a Viddie Montage. As you Add Clips the 
Settings area will be set to the defaults shown. This is also where you’ll edit a 
previously created Viddie Clip once you have selected it from the Viddie Clips Chart.  
 

VM Labs, Inc.




 33 

 
 

Figure 4.1.10 The Clip Settings Area 
 

Name 
 

This is one of the only pieces of data that doesn’t get used by NUON or 
displayed on any menu screen. We’ve included this field for the benefit of you, 
the NUON Enhancement Author. Text that you input here will be displayed in the 
Name column of the Viddie Clip Chart alongside all of the pertinent Title, Time 
In/Out, and Description data for the currently selected Viddie Clip. 

 
DVD Title 
 

The DVD Title entry field works as a text entry field with addition the standard 
increment/decrement arrows for selection of the DVD Title number that will be 
selected for use in the currently selected Viddie Clip. You will be warned to set 
this value to a range of between 1 and 99, if you try to enter a value out of that 
range. 

 
Time In / Time Out 
 

Like the DVD Title window, these are combination text and 
increment/decrement fields, where you’ll enter the In and Out times of the 
currently selected Viddie Clip. Times are shown in HH:MM:SS:FF format. As 
well, you can tab from field to field for quick entry of times. Please Note that you 
will be warned of times that are out range. As an example; 60 minutes, 60 
seconds, and 30 frames are all out of range time settings. 

 
Description 
 

The Viddie Clip Description window is where you’ll enter text, which describes 
the importance or relevance of the current Viddie Clip in relation to the whole 
Viddie Montage. This text will be displayed in the appropriate area of the Viddies 
Menu. 
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Viddie Build Action Buttons 
 

Figure 4.1.11 shows the Viddie Build Action Buttons, 
which you’ll use to test and export Viddie Montages. 

 
 
 

 
 

Test Montage 
 

Immediately plays the currently 
loaded Viddie Montage. The complete 
NUON Development System must be 
running in order for this to work. As 
well, a DVD disc must be playing in 
order for it to run. When clicked, the 
Viddie Montage will begin to play and 
the dialog box shown in Figure 4.1.12 
will be displayed. The progress bar 
indicates the approximate position in 
the Viddie Montage. The dialog will 
disappear after the Viddie Montage is completed. 

 
Export Montage 
 

Exports the current Viddie Montage 
as a Director Script format file (.dsb), 
which will run on NUON when the 
final project is built. When clicked, a 
dialog box as shown in Figure 4.1.13 
will be displayed. You’ll then select a 
Viddie Montage Number, which will 
be between 1 and 16 (the maximum number of Viddie Montages). This number 
correlates to a specific entry in the Viddies Menu, and will have been specified by 
the Creative Producer of the project. Once the number has been selected you’ll 
click enter and the Viddie Montage will be exported to the proper directory. 
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Clip Action Buttons 
 
Figure 4.1.14 shows the Viddie Action Buttons, which you’ll 
use to Add, Insert, Delete and Move Viddie Clips that appear 
in the Viddie Clips Chart.  

 
Add Clip 
 

Adds a new Viddie Clip to the Viddie Clip Chart. The 
new Viddie Clip will be added to the bottom of the 
Viddie Clip Chart. This can later be changed using the 
Move Up and Move Down buttons as described below. 

 
Insert Clip 

 
Inserts a new Viddie Clip to the Viddie Clip Chart. The 

new Viddie Clip will be inserted above the currently 
selected Viddie Clip. All Viddie Clips below the Inserted 
Clip will be moved down the Chart, and therefore play 
back in the same order. 

 
Delete Clip 

 
Deletes the currently selected Viddie Clip from the Viddie Clip Chart. All 

Viddie Clips below the Deleted Clip will be moved up the Chart, and therefore 
play back in the same order. 

 
Move Up 
 

Moves the currently selected Viddie Clip up the Viddie Clip Chart, therefore 
causing it to appear earlier in the Viddie Montage. Viddie Clips that were above 
the moved Viddie Clip are displaced to now be below it, and are played back after 
it. 

 
Move Down 
 

Moves the currently selected Viddie Clip down the Viddie Clip Chart, therefore 
causing it to appear later in the Viddie Montage. Viddie Clips that were below the 
moved Viddie Clip are displaced to now be above it, and are played back before 
it.  
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Chapter 7                      The Gamma Zoom Composer   
  

Section 7.1 - An Introduction to NUON Gamma Zooms 
 
NUON Gamma Zooms are a way for Creative Producers at the movie studio to add 

value to a DVD title by creating virtual stop-off points in a movie title, where the 
viewer can explore interesting content using Zoom, Pan and Gamma controls. This 
could include for example, showing points of historic interest used in a films setting, 
or freezing the action of an exciting space adventure film for the viewers further 
exploration. The options are endless and totally in the control of the Creative 
Producer. 

 
When presented to the viewer, Gamma Zooms appears as a menu of items to be 

explored. We refer to these points of interest as Z-Frames, which are points where the 
video is automatically paused for the viewer’s perusal. As well, there may be some 
descriptive text relating the Z-Frames importance to the title, or other significant 
information. We’ll discuss this in further detail in the next few sub-sections. 

 
The real power of Gamma Zooms, like other NUON Enhancements, is that they are 

built upon an already completed video assets, no additional editing to the film asset is 
necessary. In addition, Gamma Zooms can span all of the titles on a DVD being 
NUON Enhanced, so the main feature, as well as theatrical trailers, deleted scenes 
and director’s cuts can be used in a collection of Gamma Zooms. 

 
Section 7.2 - What is a Gamma Zoom Z-Frame? 

 
In the same way that a book publisher might pull frames of a film to use in a 

making-of type book, the Gamma Zooms Application allows a Creative Producer to 
pull, and then specify Zoom areas (called Vista Points) and make Gamma changes to 
show in greater detail what is going on in the title being enhanced with Gamma 
Zooms. 

 
Let’s use the example of the afore-mentioned space adventure film to describe a 

Gamma Zoom Enhanced project. This is of course going to be fast paced with lots of 
detail in many areas all at once. To create a Gamma Zoom of a critical moment in the 
action, the Creative Director would start by locating an exact frame where a pivotal 
encounter occurs, this done by specifying the DVD Run-time for the frame. Next, 
let’s assume that there is an approaching alien, and our heroes are taking note of this.  

 
This is where it gets interesting, as the Director can now specify those points of 

interest as Vista Points, which can then be selected by the viewer to be zoomed in on. 
As well, Gamma change can be specified for the whole Z-Frame, which would 
change relative brightness and contrast of the Z-Frame, or if desired for specific Vista 
Points. This could be used for lightening a shadowy area where some of the alien’s 
confederates might lurk, or better yet, to better show what the emblem on the rocket 
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ship says. In this example there would only be three Vista Points specified for this 
particular Gamma Zoom, but in fact the number of Vista Points has no limit. And 
finally, a sentence or two of descriptive text can be added, describing the importance 
of the Gamma Zoom frame in relationship to the title. Figure 4.2.1 shows our space 
adventure example, with the relationship between the Video Title and several Z-
Frames. One of these Z-Frames (the center one) has three Vista Points shown, which 
include close-ups of our space travelers, and their rocket ships insignia. 

 
 

 
 

Figure 4.2.1 The relationship between a Video Title, Z-Frames and Vista Points. 
 

Please note in the previous illustration, that the selected Z-Frames appear in a 
chronologically sequential order. This was only for the example. In fact, Z-Frames 
can be pulled in any order and from any Title that appears on the DVD including; 
Director’s cuts, deleted scenes, and theatrical trailers. Also, note that this example has 
been greatly simplified, and the each Z-Frame may have several Vista Points. 

 
 The Creative Producer doesn’t have to stop at one Z-Frame. In fact, we’ve set up 

templates, which will allow you to build menus with several (up to 16) Z-Frames on 
them. Once the Creative Producer has compiled  the documents for all of the desired 
Z-Frames, they’ll be sent to you, the NUON Enhancement Author. You’ll then go on 
to add these run lists to menu art and code templates with the Gamma Zoom 
Composer. 
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Section 7.3 - How Z-Frames are presented to the viewer 
 
Sitting in their favorite easy chair, the viewer will be entertained by all of this 

creative work by simply selecting the Gamma Zoom Menu, navigating to the desired 
Z-Frame and pressing enter. Figure 4.2.2 shows an example of one of the menu 
templates that we’ve included in this NUON Hybrid Kit.  

 
 

 
 

Figure 4.2.2 A NUON Menu Template, what the viewer sees. 
 
In the figure above, you’ll note first that this is a full screen bitmap image (720 X 

480 pixels) much like any other piece of DVD menu artwork. One big difference 
between this piece of art and the usual DVD menu is that NUON allows for “picture-
in-graphic” display. So, though not apparent here, the pair of swimming whales 
actually appear in a scaled down video window, in real time, and as full motion 
video! Another notable thing about NUON Features Menus is that text can be 
displayed dynamically, which is to say that, menu items or other text, such as the 
“Scene Description” text (the white text) isn’t included in the bitmap image. This text 
is displayed by NUON, and is based on the text that you’ll be entering to the Gamma 
Zoom Composer. Other graphic items, such as logos and heading text will still be part 
of the background bitmap.  

 
Section 7.4 - Working With The Gamma Zoom Application 

 
Let’s open the application and get to work! First, you’ll need to locate the 

GammaZooms.exe application in the following path, YourHardDrive:\HybridKit\bin. 

VM Labs, Inc.




 39 

Double-click the application icon and you’ll see a window that looks like Figure 
4.2.3. This is the Gamma Zoom Composer Main Window. You’ll enter pertinent 
Gamma Zoom Z-Frame information in this easy to use interface. The Gamma Zoom 
Composer is a standard window with a menu bar at the top, text entry fields, and 
buttons to make selections. 

 
 

 
 

Figure 4.2.3 The Gamma Zooms Composer Main Window. 
 
One of the most notable features of this window is the Vista Point Chart, which 

takes up most of the window’s real estate. This is where all of the Vista Point info for 
the particular Z-frame that you’re working on will be displayed. You won’t be 
making any changes here, but this chart is no less important, as it displays all of the 
info on the Z-Frame that you’re creating. Just above the chart is the Z-Frame Name 
text field, to the right are the Z-Frame Action Buttons, and below the chart are the 
Vista Point Setting fields, which is where all of the important Vista Point info is 
entered. 

 
In our example above, the Z-Frame is named “What’s The Point?” (Z-Frame 

Name), and includes three Vista Points named; “Look Over There”, “Look Over 
Here”, and “Now Look Here”. Along with each of these are X and Y coordinates 
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(corresponding to locations in the Z-Frame), Zoom Level, and Gamma checkbox and 
text entry field. The info in the window shown, when exported, will create a single 
Gamma Zoom Z-Frame named “What’s The Point”. This Z-Frame, when displayed 
by NUON will list in a menu the named Vista Points, which can then be selected by 
the viewer for zooming. 

 
Section 7.5 - Instant Gratification (A tutorial) 
 

We’ve told you enough about what a Gamma Zoom is, and a bit about the Gamma 
Zoom Composer, so finally, let’s look at how you’ll create Gamma Zoom Z-Frames. 
We’ll do this in a step-by-step fashion, so you’ll see just how simple it all is. You can 
make up text and times for this tutorial as you go along. This is just for fun, right! 
 
13. If you’re development system includes a DVD Emulator, make sure the DVD 

Drive/Emulator data switch is set to DVD Drive position. You’ll find information 
on the DVD Emulator in a separate document included with that module. 

 
14. Make sure that your NUON Development System is powered on. 

 
15. Load a DVD disc into the Reference Player disc drive. 

 
16. Select New from the File Menu if you’ve entered any info while playing around, 

and choose No in response to the “save changes” dialog. 
 

17. Enter a Z-Frame Name in the appropriate text field. 
 

18. Enter a DVD Title number into the appropriate text field. Alternately you can use 
the up/down arrows. 

 
19. Enter a Z-Frame Time in the appropriate fields. Note that you can tab from field-

to-field and enter two digit time values. You can also use the up/down arrows if 
you like. 

 
20. Enter a Pre-Roll Time, which is the number of seconds and frames that should roll 

before the Z-Frame is paused on. 
 

21. Check the Use Gamma checkbox and adjust the Gamma number value. The 
default is 5, with 6 –10 being lighter, and 0 – 4 being darker. 

 
22. Enter some descriptive text in the appropriate field. This completes the setting of 

the Z-Frame parameters. Now we’ll move on to the Vista Point Settings. 
 

23. Click the “Add Vista Point” Action Button at which time an “Untitled Vista 
Point” will appear at the top of the Vista Point Chart. 

 
24. Enter a Vista Point Name in the appropriate text field. 
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25. Enter X and Y coordinates, which have limits of  +/- 360 for X, and +/- 240 for Y. 

These values set the center position of the Zoom Area. 
 

26. Enter a Zoom Level. This sets the ratio of the Zoom, which can be up to 700%. 
 

27. Check the Use Gamma checkbox and adjust the Gamma number value. The 
default is 5, with 6 –10 being lighter, and 0 – 4 being darker. This will set the 
Gamma value for this Vista Point only. No other Vista Points will be affected. 

 
28. Now, repeat steps 11 through 15 to add more Vista Points to this Z-Frame.  

 
Pretty simple! You’ll note that as you continue to add Vista Points they are 

appended to the end of the chart. When displayed on a NUON player, these Vista 
Points will appear in the Vista Points Menu in the same order as they appear in the 
chart. 

 
You can show Z-Frames from any part of the DVD and in any order. They can be 

shown from end to beginning, or skip around, and can even jump from title to title! 
Before we go on to Export Gamma Zoom, let’s have a look at the other Vista Point 
Action Buttons. They are as follows: 
 

• Insert Vista Point, which will insert a new Vista Point into the Vista Point 
Chart above the currently selected Vista Point. 

 
• Delete Vista Point, which will delete the currently selected Viddie Clip from 

the Viddie Clip Chart. There is NO undo function for this, so be careful. 
 

• Move Up, which will move the currently selected Vista Point up the Vista 
Point Chart, and therefore to an earlier position in the Vista Point Menu. 

 
• Move Down, which will move the currently selected Vista Point down the 

Vista Point Chart, and therefore to a later position in the Vista Point Menu. 
 

(These buttons and their functioning are discussed in greater detail in the reference 
sub-section that follows this tutorial.) 

 
When you wish to save your work, select “Save As” from the File Menu, and enter 

a name for the project in the standard Save Dialog Box that appears. This is not the 
same as doing an Export, which we’ll learn about below. 

 
There’s now only one more step. All you have to do is click on the Export Gamma 

Zoom action button. A dialog box will appear and prompt you to select a Vista Point 
number. Leaving it set to 1, and clicking OK will do for now. This will automatically 
export your work to the NUON Scripting Language file format (.bob). It will be titled 
“coolZoomSet1”, and put it into the appropriate directory. This is the final step in the 
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creation of a Gamma Zoom Z-Frame. In a real project there will no doubt be several 
Z-Frames that will appear on the Gamma Zoom menu, so the previous set of steps 
will be repeated for each Z-Frame. The only difference when creating a real project is  
the selection of the Gamma Zoom number in the Gamma Zoom Export step, where 
you select the number based on what the Creative Producer has specified. 

 
For a detailed description of the functioning of all text fields, buttons, and menus of 

the Gamma Zoom Composer see the Gamma Zoom Composer Reference section of 
this manual starting on page 4.2.9. 

 
Section 7.6 - Putting It All Together 

 
Once, you’ve entered the data and exported each of the Gamma Zoom Z-Frame 

files, you’ll want to see them in the context of a menu. Though this is discussed in 
greater detail in Section 3, NUON UI Templates & Tools, we’ll briefly discuss the 
process here. 

 
In this Hybrid Kit, we’ve included templates for building NUON Menus. These 

templates include both the menu code and bitmaps for all of the currently available 
NUON Features. These templates allow you to quickly see how a NUON project is 
built, and to give you an idea how it will look when completed. Please note that the 
included bitmaps have generic headings, titles, and menu item text. They have been 
included as a starting point for Graphic Artists developing for a NUON Features 
project, as well as system test for the Development System. 

 
To build and load a NUON project to your development system you’ll need to 

follow these steps: 
 
11. If you’re development system includes a DVD Emulator, make sure the DVD 

Drive/Emulator data switch is set to Emulator position. You’ll find information on 
the DVD Emulator in a separate document included with that module. 

 
12. Make sure that your NUON Development System is powered on. 

 
13. Load a DVD disc into the Reference Player disc drive. 
 
14. Locate and open the MS-DOS Prompt (also referred to as the “DOS BOX”), 

which you’ll find under Programs in the Start Menu. 
 
15. You’ll need to navigate to the “test” directory within the NUON Composer Kit 

directory. If you’re not familiar with DOS-Prompt, command-line use or the ‘cd’ 
command see Appendix A on the DOS-Prompt. 

 
16. After the prompt, (“>”) type “makedat” to start the makedat batch file. This will 

automatically build your NUON project. If this seems to go by rather quickly, 
that’s normal, as NUON Menu files are compact and are compiled very quickly. 
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17. After the prompt, type “load” to start the load batch file. This will take 

between 12 and 15 seconds, and will display the percentage completed of each of 
the files loaded to the Development System. When complete, the currently loaded 
disc should begin to play. 

 
18. Press the Menu button on the remote to bring up the NUON Features Menu. This 

won’t say NUON Features on it, as it’s a generic template graphic. 
 

19. Navigate to the Gamma Zoom Menu with the up/down arrow keys, and press 
enter to open the Gamma Zoom Menu. 

 
20. The menu should open with “Gamma Zoom 1” already selected. Press enter to 

show your Z-Frame in full screen mode. 
 

That’s it! You’ve just built and loaded a NUON project into the Development 
System. With that said, this was just a trial run, and in order to build a real project 
you’ll want to go over Section 3 . The rest of this Section is comprised of a reference 
document, which describes in great detail all of the functions of the Gamma Zoom 
Composer. 
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Section 7.7        Gamma Zoom Application Reference 
 
 
Standard Pull-Down Menus 
 
File Menu 
 
Figure 4.2.4 shows the File Pull-Down Menu. This 
menu can either be pulled down with your pointing 
device, or invoked by the key combination Alt + F. 
Once pulled down, functions can either be selected 
with the pointing device, or invoked by hitting the 
key that corresponds to the underlined letter in the 
function name. 
 
New (Ctrl+N) 
 
Creates a New Gamma Zooms Composer Main 
Window by clearing the existing window of its 
contents. If there is an already opened window with 
project information, you’ll be prompted to save your current work through a standard 
warning dialog box. If you need to open more than one window at a time you’ll need 
to double-click the Gamma Zooms Composer application icon. 
 
Open (Ctrl+O) 
 
Opens a Gamma Zooms Composer file that you have saved. The “Open” dialog box 
will be displayed where you’ll select a file to be Opened. If there is an already Open 
file at the time that you choose to Open another, you’ll be prompted to save your 
current work through a standard warning dialog box. 
 
Gamma Zooms Composer files have the file extension .ngz and are only read by The 
Gamma Zooms Composer. This is the format, in which you’ll save your work-in-
progress, as well as finished projects, which you may wish to keep for future 
reference. These are not the files that you’ll include in your final NUON menu 
project. Those files are discussed below under the Export Gamma Zooms button 
heading. 
 
Save (Ctrl+S) 
 
Saves the currently Opened project if it has been previously “Saved As”, otherwise 
you’ll prompted to name the project in the standard Save As dialog box. 
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Save As (Ctrl+A) 
 
Saves the currently Open or New file in the Gamma Zoom Composer (.ngz) format. 
The “Save As” dialog box will be displayed, and you’ll be prompted to enter a file 
name. 
 
 
Print (Ctrl +P) 
 
Prints only the contents of the Vista Points Chart to a connected printer. You’ll be 
presented with a standard Windows print dialog box, where print options may be 
selected. 
 
Print Setup 
 
Presents a standard Windows Print Setup dialog box, allowing you to set print 
parameters for your documents. 
 
Recent Files 
 
The Recent Files area between the Print function and the Exit function is a standard 
Windows feature showing exactly that. Up to four of the last files worked with will be 
displayed here. 
 
Exit 
 
Exits the Gamma Zooms Composer application. You will be prompted to save any 
un-saved work through a standard warning dialog box. 

 
Edit Menu 

 
Figure 4.2.5 shows the Edit Pull-Down Menu. 
We’ll only give a brief description of these 
menu functions as all of them duplicate buttons 
in the Gamma Zooms Composer Main Window, 
and will be discussed in detail later. This menu 
can either be pulled down with your pointing 
device, or invoked by the key combination Alt + 
E. Once pulled down, functions can either be 
selected with the pointing device, or invoked by 
hitting the key that corresponds to the underlined letter in the function name. 
 
Add Vista Point (Ctrl +A) 
 
Adds a New Vista Point to the end of the current Z-Frame.  
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Insert Vista Point (Ctrl +I) 
 
Inserts a New Vista Point above the currently selected Vista Point. 
 
Delete Vista Point (Ctrl +D) 
 
Deletes the currently selected Vista Point from the Z-Frame.  
Beware: there is NO undo function for this! 

 
Move Up (Ctrl +Up) 
 
Moves the currently highlighted Vista Point up the Vista Point Chart, and therefore to 
an earlier position in the Vista Point menu.  
 
Move Down (Ctrl +Down) 
 
Moves the currently highlighted Vista Point down the Vista Point Chart, and 
therefore to a later position in the Vista Point menu. 
 
Export Viddie (Ctrl +E) 
 
Is the final step in creating your Gamma Zoom Z-Frame. 

 
Help Menu 

 
Figure 4.2.6 shows the Help Pull-Down Menu. This 
menu can either be pulled down with your pointing 
device, or invoked by the key combination Alt + H. 
Once pulled down, the function can either be selected with the pointing device, or 
invoked by hitting the A . 
 
About NUON Gamma Zooms Composer… 
 
You can find the software revision number and copyright information here.  
 
Gamma Zoom Z-Frame Settings 
 
Figure 4.2.7 shows the Gamma Zoom Settings area of the Main Gamma Zoom 
window. Encompassed here are all of the parameters that pertain to a Gamma Zoom 
Z-Frame, including Name, Title, Times, Gamma and Description. Parameters specific 
to Vista Points live in their own area below the Vista Point Chart. 
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Figure 4.2.7 The Gamma Zoom Z-Frame Settings area 
 

Name 
 
This is you’ll type the name of the Gamma Zoom Z-Frame, that will be displayed on 
the Gamma Zoom Menu that is presented to the viewer. So, spelling does count. 
 
DVD Title 
 
Selects the DVD Title for the Z-Frame to be pulled from. Remember, you can pull a 
Z-Frame from any title on a DVD, including the Main Feature, Director’s Cuts, 
Theatrical Trailers, etc… You can highlight and type over the default value, or use 
the spinners to select titles 1 thru 99. 
 
Time 
 
Sets the Z-Frame stop time in Hours, Minutes, Seconds, and Frames. This is where 
the Z-Frame will pause after the defined Pre-Roll Time that you set. You can 
highlight and type over any of the time values, or use the spinners to select time 
values. The Hours value is limited to 4. The Minutes and Seconds values are of 
course limited to 59. And, the Frames value is limited to 29. 
 
Pre-Roll Time 
 
Sets the Pre-Roll Time in Seconds, and Frames. This is the amount time that video 
will be played before the Z-Frame is paused on. The Seconds value is of course 
limited to 59. And, the Frames value is limited to 29. 
 
Use Gamma 
 
Uses the Gamma Level set, if the checkbox is checked. The default value of 5 is 
neutral and you’ll see no difference in the gamma of the image. Gamma values 
between 6 and 10 will cause the image to look brighter, while values of 0 to 4 cause a 
darker appearance. This Gamma setting will affect the whole Z-Frame when it is 
displayed in full screen mode. 
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Viddie Clip Chart 
 

Figure 4.2.8 shows the Vista Point Chart, which is where you’ll add, insert, 
delete and otherwise arrange Vista Points in Z-Frames. This is the main display 
area of the Gamma Zoom Composer, and most of the other controls in the main 
window have a direct effect on the chart. Specifically, the Vista Point Setting 
controls are used to  edit the Vista Point parameters that appear in this chart. 

 
The only direct effect that you can have on the chart is to select individual Vista 

Points for editing (with the aforementioned controls), as well as resizing the chart 
columns to accommodate showing text of differing lengths, though this shouldn’t 
be necessary most of the time.  

 

 
 

Figure 4.2.8 The Vista Point Chart 
 
Vista Point Settings 
 
Figure 4.2.9 shows the Vista Point Settings area. This is where you’ll make all of the 
settings for each of the Vista Points in a Z-Frame. As you Add Vista Points the 
Settings area will be set to the defaults shown. This is also where you’ll edit a 
previously created Viddie Clip once you have selected it from the Viddie Clips Chart.  
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Figure 4.2.9 The Vista Point Settings Area 
Name 
 

This is one the only pieces of data that doesn’t get used by NUON or displayed 
on any menu screen. We’ve included this field for the benefit of you, the NUON 
Enhancement Author. Text that you input here will be displayed in the Name 
column of the Vista Point Chart along side all of the pertinent X/Y, Zoom, and 
Gamma data for the currently selected Vista Point. Each Vista Point of a Z-Frame 
has will have its own Name. 

 
X and Y (Vista Point Coordinates) 
 

Sets the X (horizontal) and Y (vertical) coordinates of the Vista Point. The 
origin point for X/Y is in the exact center of the 720w X 480h frame, so X values 
of between +/- 320, and Y values of +/- 200 are possible. Negative X values will 
set the Vista Point X to the left of the centerline, positive to the right. 
Negative Y values will set the Vista Point Y above the centerline, positive below 
it. Each Vista Point of a Z-Frame has will have its own X and Y coordinates. 

 
******************************************************************
* 

 
Zoom Level 
 

Sets the Zoom Level of the Vista Point to 100% (no effect) thru 700%. Each 
Vista Point of a Z-Frame has will have its own Zoom Level. 

 
Use Gamma 
 

Uses the Gamma Level set, if the checkbox is checked. The default value of 5 is 
neutral and you’ll see no difference in the gamma of the image. Gamma values 
between 6 and 10 will cause the image to look brighter, while values of 0 to 4 
cause a darker appearance. This Gamma setting will affect only the specific Vista 
Point (as opposed to the Z-Frame Gamma setting, which affects the whole Z-
Frame) when it is displayed in full screen mode. Each Vista Point of a Z-Frame 
has will have its own Use Gamma settings. 

 
Gamma Zoom  
Build Action Button 
 

Figure 4.2.10 shows the Viddie Build Action 
Button, which you’ll use to export Gamma Zoom 
Z-Frames. 
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Export Gamma Zoom… 
 

Exports the current Z-Frame as a NUON 
Scripting Language file (.bob), which will 
run on NUON when the final project is built. 
When clicked, a dialog box as shown in 
Figure 4.2.11 will be displayed. You’ll then 
select a Gamma Zoom Set number, which will be between 1 and 16 (the 
maximum number of Gamma Zoom Z-Frames). This number correlates to a 
specific entry in the Gamma Zoom Menu, and will have been specified by the 
Creative Producer of the project. Once the number has been selected you’ll click 
enter and the Gamma Zoom Set will be exported to the proper directory. 

 
Vista Point Action Buttons 
 
Figure 4.1.12 shows the Vista Point Action Buttons, 
which you’ll use to Add, Insert, Delete and Move 
Vista Points that appear in the Vista Point Chart.  

 
Add Vista Point 
 

Adds a new Vista Point to the Vista Point Chart. 
The new Vista Point will be added to the bottom 
of the Vista Point Chart. This can later be changed 
using the Move Up and Move Down buttons as 
described below. 

 
Insert Vista Point 

 
Inserts a new Vista Point to the Vista Point 

Chart. The new Vista Point will be inserted above 
the currently selected Vista Point. All Vista Point 
below the Inserted Vista Point will be moved 
down the Chart, and therefore play back in the 
same order. 

 
Delete Vista Point 

 
Deletes the currently selected Vista Point from the Vista Point Chart. All Vista 

Points below the Deleted Vista Point will be moved up the Chart, and therefore 
play back in the same order. 
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Move Up 
 

Moves the currently selected Vista Point up the Vista Point Chart, therefore 
causing it to appear earlier in the Gamma Zoom Menu. Vista Points that were 
above the moved Vista Point are displaced to now be below it, and are therefore 
seen after it. 

 
Move Down 
 

Moves the currently selected Vista Point down the Vista Point Chart, therefore 
causing it to appear later in the Gamma Zoom Menu. Vista Points that were below 
the moved Vista Point are displaced to now be above it, and are therefore seen 
before it.  
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Chapter 8                 The Dynamic Chapter Composer    
  

Section 8.1 - An Introduction to NUON Dynamic Chapter Selection 
 
NUON Dynamic Chapters are a way for Creative Producers to add value to a DVD 

title by creating a much more intuitive chapter menu. With Dynamic Chapters the 
viewer can not only see the video asset that they’re looking for, but read dynamically 
written descriptions of each scene as they’re selected. And all of this comes at an 
extremely low hit to post-production time. 

 
When presented to the viewer, Dynamic Chapters appears as a menu of items to be 

selected. As well, there may be some descriptive text relating the chapter’s 
importance to the title, or other significant information. We’ll discuss this in further 
detail in the next few sub-sections. The real power of Dynamic Chapters, like other 
NUON Enhancements, is that they are built upon already completed video assets, and 
no additional editing to the film asset is necessary. 

 
Section 8.2 - How NUON Dynamic Chapter Selection is presented to the viewer 

 
Sitting in their favorite easy chair, the viewer will be entertained by all of this 

creative work by simply selecting the Dynamic Chapter Menu, navigating to the 
desired Chapter Name and pressing enter. Figure 4.2.1 shows an example of one of 
the menu templates that we’ve included in this NUON Hybrid Kit.  

 

 
 

Figure 4.3.1 A NUON Menu Template, what the viewer sees. 
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In the figure above, you’ll note first that this is a full screen bitmap image (720 X 
480 pixels) much like any other piece of DVD menu artwork. One big difference 
between this piece of art and the usual DVD menu is that NUON allows for “picture-
in-graphic” display. So, though not apparent here, the pair of swimming whales 
actually appear in a scaled down video window, in real time, and as full motion 
video! Another notable thing about NUON Features Menus is that text can be 
displayed dynamically, which is to say that, menu items or other text, such as the 
“Scene Description” text (the white text) isn’t included in the bitmap image. This text 
is displayed by NUON, and is based on the text that you’ll be entering to the 
Dynamic Chapter Composer. Other graphic items, such as logos and heading text will 
still be part of the background bitmap.  

 
Section 8.3 - Working With The Dynamic Chapter Composer 

 
Let’s open the application and get to work!  

 

 
 

Figure 4.3.2 The Dynamic Chapter Composer Main Window. 
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First, you’ll need to locate the DynamicChapters.exe application in the following 
path YourHardDrive:\HybridKit\bin. Double-click the application icon and you’ll see 
a window that looks like Figure 4.2.2. This is the Dynamic Chapter Composer Main 
Window. You’ll enter pertinent Dynamic Chapter information in this easy to use 
interface. The Dynamic Chapter Composer is a standard window with a menu bar at 
the top, text entry fields, and buttons to make selections. 

 
One of the most notable features of this window is the Chapter Chart, which takes 

up most of the space within the window. This is where all of the Chapter specific 
information will be displayed. You won’t be making any changes here, but this chart 
is no less important, as it displays all of the info on the Dynamic Chapter listing that 
you’re creating. Just above the chart are the Dynamic Chapter Global Settings, to the 
right is the Dynamic Chapter Action Button, and below the chart are the Chapter 
Setting fields, which is where all of the important Chapter information is entered. 

 
In Figure 4.3.2, the DVD Title to be listed for the Dynamic Chapter Menu is Title 1, 

and there will be 3 Chapters listed. The 3 Chapters are named; “Car Blows Up”, 
“Getting Started” and “Love Scene”. As well, each of these listed Chapters has a 
short piece of descriptive text associated with them. The info in the window shown, 
when exported, will create a single Dynamic Chapter listing This listing, when 
displayed by NUON will list in a menu the named Chapters, which can then be 
selected, along with their respective descriptive text by the viewer. 

 
Section 8.4 - Instant Gratification (A tutorial) 
 

Text 
 

Section 8.5 - Putting It All Together 
 
Text 
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 Section 8.6     Dynamic Chapter Composer Reference 
 
 

Standard Pull-Down Menus 
 
File Menu 
 
Figure 4.2.4 shows the File Pull-Down Menu. This 
menu can either be pulled down with your pointing 
device, or invoked by the key combination Alt + F. 
Once pulled down, functions can either be selected 
with the pointing device, or invoked by hitting the 
key that corresponds to the underlined letter in the 
function name. 
 
New (Ctrl+N) 
 
Creates a New Dynamic Chapter Composer Main 
Window by clearing the existing window of its 
contents. If there is an already opened window with 
project information, you’ll be prompted to save your current work through a standard 
warning dialog box. If you need to open more than one window at a time you’ll need 
to double-click the Dynamic Chapter Composer application icon. 
 
Open (Ctrl+O) 
 
Opens a Dynamic Chapter Composer file that you have saved. The “Open” dialog 
box will be displayed where you’ll select a file to be Opened. If there is an already 
Open file at the time that you choose to Open another, you’ll be prompted to save 
your current work through a standard warning dialog box. 
 
Dynamic Chapter Composer files have the file extension “.ndc” and are only read by 
The Dynamic Chapter Composer. This is the format, in which you’ll save your work-
in-progress, as well as finished projects, which you may wish to keep for future 
reference. These are not the files that you’ll include in your final NUON menu 
project. Those files are discussed below under the Export button heading. 
 
Save (Ctrl+S) 
 
Saves the currently Opened project if it has been previously “Saved As”, otherwise 
you’ll prompted to name the project in the standard Save As dialog box. 
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Save As (Ctrl+A) 
 
Saves the currently Open or New file in the Dynamic Chapter Composer (.ndc) 
format. The “Save As” dialog box will be displayed, and you’ll be prompted to enter 
a file name. 
 
 
Print (Ctrl +P) 
 
Prints only the contents of the Chapter Chart to a connected printer. You’ll be 
presented with a standard Windows print dialog box, where print options may be 
selected. 
 
Print Setup 
 
Presents a standard Windows Print Setup dialog box, allowing you to set print 
parameters for your documents. 
 
Recent Files 
 
The Recent Files area between the Print function and the Exit function is a standard 
Windows feature showing exactly that. Up to four of the last files worked with will be 
displayed here. 
 
Exit 
 
Exits the Dynamic Chapter Composer. You will be prompted to save any un-saved 
work through a standard warning dialog box. 

 
Edit Menu 

 
Figure 4.2.5 shows the Edit Pull-Down Menu. This menu can 
either be pulled down with your pointing device, or invoked 
by the key combination Alt + E. Once pulled down, functions 
can either be selected with the pointing device, or invoked by 
hitting the key that corresponds to the underlined letter in the 
function name. 

 
Export (Ctrl +E) 
 
Is the final step in creating your Dynamic Chapter listing. 
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Help Menu 
 

Figure 4.2.6 shows the Help Pull-Down Menu. 
This menu can either be pulled down with your 
pointing device, or invoked by the key 
combination Alt + H. Once pulled down, the function can either be selected with the 
pointing device, or invoked by hitting the A . 
 
About NUON Dynamic Chapter Composer… 
 
You can find the software revision number and copyright information here.  
 
Dynamic Chapter Global Settings 
 
Figure 4.2.7 shows the Dynamic Chapter Settings area of the Main Dynamic Chapter 
window. Encompassed here are the parameters that pertain to a Dynamic Chapter 
including DVD Title, The Number of Chapters in that title. Parameters specific to 
each of the Chapters live in their own area below the Chapter Chart. 
 

 
 

Figure 4.2.7 The Dynamic Chapter Global Settings area 
 
DVD Title 
 
Selects the DVD Title that your Dynamic Chapter Menu will refer to. Remember, you 
can build a Dynamic Chapter listing based on only one DVD Title for any NUON 
Hybrid Disc. You can highlight and type over the default value, or use the spinners to 
select titles 1 thru 99. 
 
Number of Chapters 
 
Sets the total number of chapters to be listed in the Dynamic Chapter Menu. You can 
highlight and type over the default value, or use the spinners to select titles 1 thru 99. 
 
Chapter Chart 
 

Figure 4.2.8 shows the Chapter Chart, which is where you’ll select chapters to 
then edit their Names and Descriptions in the Chapter Settings area. This is the 
main display area of the Dynamic Chapter Composer, and all of the other controls 
in the main window have a direct effect on the chart. Specifically, the Chapter 
Setting controls are used to edit the Chapter text info that appears in this chart. 
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The only direct effect that you can have on the chart is to select individual 
Chapters for editing by clicking anywhere within a chapter’s row. As well, you 
can resize the chart columns to accommodate showing text of differing lengths. 

 
 

 
 

Figure 4.2.8 The Chapter Chart 
 
Chapter Settings 
 
Figure 4.2.9 shows the Chapter Settings area. This is where you’ll make all of the 
settings for each of the Chapters. This is also where you’ll edit previously created 
Chapter info once you have selected it from the Chapter Chart.  
 
 

 
 

Figure 4.2.9 The Chapter Settings Area 
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Number 
 
This is the only piece of data that is not editable. It’s here only to re-iterate the 

currently selected Chapter number. 
 
Name 
 

This is where you’ll enter the Chapter Name that will be displayed in the 
Dynamic Chapter Menu, when displayed in NUON. 

 
Description 
 

This is where you can enter text describing each chapter, it’s highlights, or 
relevance to the DVD Title. 

 
Dynamic Chapter 
Build Action Button 
 

Figure 4.2.10 shows the Dynamic Chapter Build Action 
Button, which you’ll use to export Dynamic Chapter 
listings. When you do press this button, a proprietary 
NUON file will be exported the appropriate directory, 
and you’re done with the Dynamic Chapter Composer.  
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                                                                            Glossary  
 

Binary: (Binary file) In cases where it is used in this manual; a file that can be 
interpreted by the NUON DVD player engine. This is alternately referred to as “byte 
code” or “machine code”. 
 
NUON Special Features Applications: A suite of software applications, such as 
Viddie Composer, Gamma Zooms Composer, and Dynamic Chapter Composer, 
which allows for the creation of NUON Enhanced DVD Features. 

 
NUON Enhancement Author: One who creates NUON Enhanced DVD Titles. You. 
 
NUON Reference Player: The DVD disc playing hardware part of the NUON 
Development System. 
 
Run Time: (or Run-time) refers to something that happens while a piece of software 
is actually running. In cases where it is used in this manual, ******************** 
 
Viddie Clip: Is the smallest unit within a Viddie Montage. An individual shot, scene, 
or sequence defined by an “In” and an “Out” runtime, which will usually be defined 
by creatives at the movie studio. 
 
Viddie Montage: A thematic collection of shots, scenes or sequences. Made up of 
Viddie Clips. 
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